Using OneNote as a Laboratory Notebook

v2020-02

Jo Montgomery

babraham.bioinformatics@babraham.ac.uk
Laboratory Notebooks
What should we be doing?

• Expectations and responsibilities
  – Document what we are doing
  – Be able to find results
  – Timely/traceable/retrievable
  – Checked

• Legal responsibilities
Why OneNote?

- Digital Notebook
- Gathers notes – handwritten or typed – drawings, screen clippings, images and audio content
- Notes can be shared
OneNote
Storing notebooks

• Where can we save OneNote notebooks?
  – Local drives (OneNote 2016)
  – Microsoft
    • OneDrive
    • SharePoint
Electronic Laboratory Notebook (ELN)

https://babraham.sharepoint.com/sites/ELN/SitePages/Home.aspx

or go to Office.com and search Sharepoint/ELN
Electronic Laboratory Notebook (ELN)
Electronic Laboratory Notebook (ELN)
Electronic Laboratory Notebook (ELN)

Table of contents
Thursday, March 28, 2019  11:58 AM

Protocols
- Animals
- Collection
- Sequencing
- Experiment 123
- Experiment 456
- Experiment 789
Electronic Laboratory Notebook (ELN)
Storage and organisation

SharePoint
Storage and organisation

SharePoint

ELN

JM

SA

FK

Notebook 1

Notebook 1

Notebook 1

Notebook 2

Notebook 2

Notebook 2

Notebook 3

Notebook 3

Section A

Section B

Section C

Page 1

Page 2

Page 3
Storage and organisation
Exercise 1

Accessing the Electronic Laboratory Notebook (ELN) area on Sharepoint

https://babraham.sharepoint.com/sites/ELN/SitePages/Home.aspx
Getting started
What is a Page?

“It’s not a word document...

... It’s a stream of consciousness...”

Simon Andrews, Head of Bioinformatics
What is a Page?

Page B
29 January 2019 12:36


Protocol
First we collected some water. Then we filtered the water.

To make tea:
Boil the water (only once – Jo is very fussy about using freshly drawn water and not re-boiling it. Simon thinks this is unnecessary). Then apply hot water to tea of choice for required time. Add milk as required.

To make coffee:
See separate protocol as there are many sources of coffee and machines with which to provide it in-bioharm.

<table>
<thead>
<tr>
<th>Biscuit</th>
<th>Tea</th>
<th>Coffee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simon</td>
<td>Bisto</td>
<td>occasionally</td>
</tr>
<tr>
<td>Jennie Dodger</td>
<td>Builders</td>
<td>occasionally</td>
</tr>
<tr>
<td>Arena</td>
<td>From-milk, 1 sugar</td>
<td></td>
</tr>
<tr>
<td>Tests</td>
<td>Leithuen</td>
<td>various</td>
</tr>
<tr>
<td>Jo</td>
<td>Web, black, no milk</td>
<td></td>
</tr>
<tr>
<td>Laura</td>
<td>Millionaire's shortbread</td>
<td>milk</td>
</tr>
</tbody>
</table>

I can move text boxes about
Add Sections and Pages
Add Sections
Add Sections
Add Sections
Add Sections

OneNote Online | JM > JM notebook1 | JM notebook1
---|---|---
File | Home | Insert | Draw | View | Print
Tell me what you want to do | Open in OneNote
Paste
Undo | Clipboard

### RNA Seq

Tuesday, March 26, 2019  3:47 PM

- Contents
- RNA Seq
- Protocols
- Bioinformatics
- DNA methylation
- Experiment 1
- Test section
Text page

Tuesday, March 25, 2019  8:08 PM
RNA Seq
Tuesday, March 26, 2019 5:47 PM

- Protocols
  - 10X Single cell RNA Seq
- Bioinformatics
  - DNA methylation
- Experiment 1
  - 10X Single cell RNA Seq
Add sub pages
Exercise 2

Opening a new OneNote (Online) notebook and setting it up
Exercise 2

Create a Notebook to look like this – sections, colours, pages, titles and levels of organisation
What can you do in OneNote?
What can you do in OneNote?

• Add text
• Make tables
• Insert images
• Insert/attach files
• Add links
Stuff you don’t need

• Audio
• Translation tool
• Stickers
• Emojis 😊
• ...things you don’t need in a laboratory notebook
How to add things

New page

Wednesday, March 27, 2019  9:25 AM

Click anywhere on the page to start typing.
New page

Wednesday, March 27, 2019  9:25 AM

Click anywhere on the page to start typing.
Tables

Text page
Tuesday, March 26, 2019  3:08 PM

Click anywhere on the page to start typing.

<table>
<thead>
<tr>
<th>Name</th>
<th>Biscuit choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simon</td>
<td>Jammie dodger</td>
</tr>
<tr>
<td>Jo</td>
<td>Ginger nut</td>
</tr>
<tr>
<td>Anne</td>
<td>Chocolate</td>
</tr>
</tbody>
</table>
Images

- File
- Web search
- Clipboard
  - copy & paste
  - screen grab/clip
Images
Images

+ Shift + S

+ Shift + 4
Exercise 3

Adding text, tables, formatting and images
Exercise 3

Protocol

First we collected some water.

Then we heated the water.

To make tea:

Boil the water (only once – it is very fuzzy about using freshly drawn water and not re-boiling it; Simon thinks this is non-negotiable).

Then apply hot water to tea of choice for required time. Add milk/milk alternatives/sugar as required.

To make coffee:

see standard protocol here as there are many sources of coffee and machines with which to provide it in Bioinformatics.
Add files and links

• File
  – Attachment
  – File printout

• Link
  – Point elsewhere
Add files and links

Upload to OneDrive and insert link

Selecting this option uploads a copy of one or more files to your OneDrive account (the same account on which you store your current OneNote notebook). A link to each file is then inserted on the current page in your notebook. Using this option can help to reduce the size of your notebooks by keeping the source files on OneDrive, and you can easily invite other people to view and contribute to those files.

**Note:** If you must frequently use OneNote offline because of limited or no Internet access (for example, during air travel), this option may limit your ability to maintain access to all of your information during such times.

For each uploaded file, OneNote inserts a clickable link that points back to the source file on OneDrive. For any inserted file that is associated with a Microsoft Office app (such as a Word document, an Excel spreadsheet, or a PowerPoint presentation), OneNote also displays a live preview of the file contents in your notes. This lets you view and browse through the file contents quickly and easily, without having to open the file in the associated app.
Add files and links

Insert as attachment

Selecting this option inserts a copy of one or more files as separate attachments in OneNote. Once inserted, attached files have no link to their source files, so any changes you make to them in OneNote will exist only there. This option is a good choice for collecting static “snapshots” of information from multiple sources (for example, while doing research for a project) or to keep information available in OneNote even when you’re working offline.

**Note:** An attachment is an unlinked copy of the original source file. Any changes you make to the source file or to the copied attachment won’t be applied to the other.

For each attached file, OneNote inserts a file icon in your notes. Double-clicking the icon opens its contents for editing in the associated app (for example, Microsoft Word when opening a Word document).

Insert as printout

Selecting this option inserts the contents of a PDF (Portable Document Format) file as a virtual “printout” by importing the contents of the file as a series of images (one image per “page”). Once placed in your notes, each printout image can be selected, resized, moved, and annotated, but they can’t be edited like normal text. This option is a good choice for PDFs whose original formatting you want to preserve (for example, files containing elaborate tables and charts, diagrams, or richly formatted lists).

In OneNote for Windows 10, you can also choose to insert the contents of Microsoft Word, Excel, or PowerPoint files as printouts. Support for these additional file types is currently rolling out to customers.
Insert a File

OneNote

Notes on Data

Thursday, March 28, 2019  10:09 AM

You can:

- Attach a file or file printout – OK for small files. If you amend the original file, it doesn’t update the paper notebook.

- With bigger datasets such as sequencing data, you can have their own storage and archiving systems.

- Or just reference where in Sierra located.

- Create a non-dynamic link referencing: "O:\Training\OneNote\test PDF.pdf"

- Use screen shots to document what you did.

Babraham Bioinformatics
Insert a File
Add links
Add links

• Link to files stored elsewhere
  – Large datasets
  – Obligations regarding finding data
Add links

• Link to files stored elsewhere
  – Direct link doesn’t work – tries to make the file path a URL
  – 2 options
Add links

1. Give file location
   - **Shift + Right Click** on file in finder > *copy as path*
   - Paste text into OneNote as a record of where the file is stored
   - Make sure the file location doesn’t change
Add links
Add links

New page

Wednesday, March 27, 2019 9:25 AM

"D:\Training\training course checklist.docx"
Add links

2. Turn the path into a URL
   • Remove ‘http’ and type ‘file://’ at the start, remove all backslashes (\) and replace with forward slashes (/)
   • Remove spaces and replace with %20
   • Not a dynamic link
   • Copy this link into browser and it should go to file location
Add links in OneNote 2016

• Click on the folder icon to insert a (dynamic) link to a file stored in BI files

• Doesn’t work in OneNote online
• OneNote for Windows 10 takes you straight to a file browser to add
Exercise 4

Adding files and links

http://www.bioinformatics.babraham.ac.uk/training.html#onenote

OneNote Course Data files (zip)
Other useful stuff

• Draw
• To Do list
• Quick note
Draw
Write notes on slides

- Send PowerPoint or Word docs to OneNote
- Annotate with a stylus on your tablet
- Highlight and finger-paint

OR

in your taskbar

+ N on your keyboard
To Do list

- RNA Seq
- 10X Single cell RNA Seq
- DNA methylation
- Page X
- Add files
- ChiP Seq
- Page B

Tags:
- Important
- Question
- Remember For Later
- Definition
- Highlight
- Contact
- Address
- Phone Number
- Website To Visit
- Idea
- Password
- Critical
- Project A
- Project B
Add a Time and Date stamp
Table of Contents

• Create a Table of Contents with Links
• 2016: Insert > Link > My Notebook
  and navigate through the Sections/pages to add
• OneNote 2016, 10 and mac
  [[pagetitleofexistingpage]]
• OneNote Online – copy URL for notebook/section/page and add this as a link
<table>
<thead>
<tr>
<th>Protocols</th>
<th>RNA Seq</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10X Single cell RNA Seq</td>
</tr>
<tr>
<td></td>
<td>DNA methylation</td>
</tr>
<tr>
<td></td>
<td>CHIP Seq</td>
</tr>
</tbody>
</table>

**RNA Seq**

Tuesday, March 26, 2019 3:47 PM

**10X Single cell RNA Seq**

Display text:

DNA methylation

Address:

https://bebrahesharepoint.com/sites/ELV/JM/_{layouts}/15/Wopi
Page backgrounds and lines

- View > Paper Style
- View > Paper color
Other hints and tips

• Indent and outdent

• Alt + Shift +

• Rearrange order in a list using

• Alt + Shift +
Other hints and tips

• Maths functions

OneNote 10
Search Text


Curabitur a felis id ex molestie rutrum. Commodo sed sapien ac sagittis. Integer non diam velit, et aliquam nisi.

Maureus non et scelerisque, molestie risus, varius venenatis risus.

Pellentesque porta gravida tempus. Pellentesque eget massa vel suscipit. Pellentesque eget massa vel suscipit.


Integer tempus purus justo, at cursus dui. Sed id dolor nec posuere volutpat. Mauris accumsan non massa ac varius.

Babraham Bioinformatics
Search Text in an Image
References

• OneNote is not a reference management system
• You can link to a reference management system such as Reference Manager or EndNote if you must
Exercise 5

Other useful tools
Sharing OneNote notebooks

• Sharepoint ELN
• OneDrive
• Other locations
Sharing a page - OneNote 2016
Sharing a page - OneNote 2016
Sharing OneNote notebooks

Link settings

Who would you like this link to work for? Learn more

- Anyone with the link
- People in BABRAHAM with the link
- People with existing access
- Specific people

Other settings

- Allow editing

Apply | Cancel
Versions
Versions

3/28/2019 Jo Montgom...

Notes on Data

Thursday, March 28, 20...

You can:

- Attach a file
- If you amend the or paper notebook.

- You can add a
- With bigger dl have their own
- Or Just referen...
Exercise 6

Share your notebook with someone in the room

https://tinyurl.com/test-lab-book
Suggestions for use as a Laboratory Notebook

Example Laboratory Notebook

https://tinyurl.com/template-lab-book
Exercise 7

Set up an outline for a laboratory notebook to suit your experiments
The future: Windows 10 and Office 2019

- Microsoft is ‘sunsetting’ OneNote2016
- OneNote for Windows10 looks more like the mac or online version
OneNote for Windows 10
The future: Windows 10 and Office 2019

• There are some NEW features in OneNote 10 which aren’t available in OneNote 2016
• Microsoft is recreating popular OneNote 2016 features in OneNote for Windows 10.
• OneNote 2016 still has a number of features that OneNote for Windows 10 lacks...
• Some are scheduled for OneNote for Windows 10 and some aren’t...
Further help

https://support.office.com